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In this Guide...
In this Guide...

This installation guide provides instructions to install and configure the 
OpenLab EZChrom workstations. It is designed to help system administrators 
and other users install the software quickly and correctly.

Table 1 Terms and abbreviations used in this document

Term Description

CDS Chromatography Data System

EZChrom OpenLab EZChrom

Data Store OpenLab Data Store; as of rev. 3.4, the product name is 

OpenLab Server 2.5

OpenLab Server New product name, formerly known as OpenLab Data Store.

Content Management Data storage component provided as part of OpenLab Server

ECM OpenLab Enterprise Content Manager

AIC Agilent Instrument Controller

Control Panel OpenLab Control Panel

Microsoft Control Panel Part of the Microsoft Windows operating system

Shared Services Set of components and services for licensing, users and roles, 

instrument configuration, security policy and more.

Installed on all computers; accessed via the OpenLab Control 

Panel.

OpenLab Shared Services Server Server running the Shared Services.

Formerly known as OpenLab Shared Services Server.
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In this Guide... 
1 Configure your Workstation PC

Agilent-delivered PC Bundle systems are delivered with the supported 
pre-installed Windows operating system and are configured for optimum 
performance. Non-Agilent PC Bundle systems require some manual 
configuration changes in order to provide optimum performance. This chapter 
describes how to configure a non-Agilent PC Bundle system.

2 Install the Software

The installation is automated by the OpenLab EZChrom Master Installer. This 
tool installs the various components of EZChrom. 

3 Post Installation Tasks

This chapter describes tasks that are relevant after finishing the installation.

4 Optional Procedures

This chapter contains information on the Additional Drivers and Software 
wizard, on the Software Verification Tool, and other helpful procedures.

5 Licensing

This chapter contains information on how to obtain and install a license.

6 Configure OpenLab EZChrom in the Control Panel

This chapter describes the initial configuration steps after installing the 
software. Refer to the online help for more information.

7 Upgrade EZChrom Edition to Latest Version

This chapter describes the upgrade from EZChrom Edition A.04.0x.

8 Uninstall the Software

This chapter contains information on the uninstallation by using the OpenLab 
EZChrom Uninstallation Wizard. It also describes post uninstallation tasks 
that are essential if you plan to reinstall EZChrom on the same computer.
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OpenLab EZChrom Workstation Installation
1
Configure your Workstation PC

Agilent-delivered PC Bundle systems are delivered with the supported 

pre-installed Windows operating system and are configured for optimum 

performance. Non-Agilent PC Bundle systems require some manual 

configuration changes in order to provide optimum performance. This chapter 

describes how to configure a non-Agilent PC Bundle system.
8Agilent Technologies



Configure your Workstation PC  
About Configuration
About Configuration

Some changes within this document are mandatory for OpenLab EZChrom to 
work properly on a Windows system. Some changes will optimize application 
performance. Other changes will have a graphical or minor impact.

NOTE To indicate the relative importance of individual settings, each item is categorized as:

MUST: These changes must be applied.

PERFORMANCE: These changes will improve system performance.

OPTIONAL: Most of these changes will affect the graphical display of the application.

NOTE If User Account Control (UAC) is switched on, some configuration steps will require active 

confirmation to continue.
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Configure your Workstation PC  
Installing Windows
Installing Windows

1 Install Windows from the Microsoft installation media. During the setup, 
provide the computer name, administrator password and network settings. 
Choose to either join an existing domain or set up the system in a 
workgroup mode.

2 To secure your system against viruses please install an antivirus program. 
Be sure to open the firewall ports listed in the Firewall Settings in the 
OpenLab EZChrom Requirements guide.

NOTE Keep your PC disconnected from the internet until you have installed the appropriate 

security patches and hot fixes. Install the latest security fixes as supported from Agilent 

Technologies and virus definitions prior to connecting to a network.

NOTE Running antivirus programs might influence the behavior and performance of your 

computer. Some virus scanners might cause issues when used with OpenLab EZChrom. 

The application has been tested with Symantic Endpoint Protection, Trend Micro, Microsoft 

Security Essentials, McAfee. Any of these antivirus software is recommended. However, 

the support is not limited to these antivirus software products. Each product may have 

specific language requirements and support.
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Configure your Workstation PC  
Configuring Windows 10
Configuring Windows 10

[MUST] 1 System (Microsoft Control Panel)1: Register Windows with Microsoft.

[MUST] 2 File Explorer Options (Microsoft Control Panel): In the View tab,
• Select Always show menus.
• Select Display the full path in the title bar.
• Clear Hide extensions for known file types.
• Clear Use Sharing Wizard.

[MUST] 3 Start > Settings > Update and Security:
a Click Check for updates to check for updates and apply all critical security 

patches. 
Before proceeding, ensure that all updates are downloaded and installed. Ensure 
that there is no reboot pending.

b Click Advanced options.
c Select the Defer feature updates check box.
d Click Choose how updates are delivered.
e Turn off Updates from more than one place.

[MUST] 4 Settings for updates: Windows Update service MUST NOT be running during 
installation.

[MUST] 5 Indexing Options (Microsoft Control Panel): Disable indexing.
Click the Modify button. Clear all drives and locations. 

[MUST] 6 Start > search for 'gpedit.msc': Windows logon options
a Navigate to Local Computer Policy > Computer Configuration > Administrative 

Templates > System > Logon.
b Set Hide entry points for Fast User Switching and Always use classic logon to 

Enabled.

1 View the items by icon to see a list of all items.
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Configure your Workstation PC  
Configuring Windows 10
WHEN [MUST] 7 Start > Settings > System > Tablet Mode: For When I sign in, select Use desktop 
mode.

[MUST] 8 Power Options (Microsoft Control Panel):
a As preferred plan select High performance

b Click Change Plan settings

c Set the option Put the computer to sleep to Never.
d Click Change advanced power settings. 
e Open the nodes for Hard disk > Turn off hard disk after.
f Set the Minutes to 0 (=Never).

[MUST] 9 Start > Settings > System > Offline Maps: Turn Metered connections and Map 
updates off.

[MUST] 10 Administrative Tools (Microsoft Control Panel): Configure security options:
a Double-click Local Security Policy.
b Navigate to Security Settings > Local Policies > Security Options

c Double-click the following policy listed in the right hand panel: Network Access: 
Sharing and security model for local accounts

d In the displayed dialog select the following item from the drop-down list: Classic - 
local users authenticate as themselves

[MUST] 11 Start > Settings > System and Security:
a Click Change Windows SmartScreen settings.

b Select Don't do anything (turn off Windows SmartScreen).

[MUST] 12 Date and Time (Microsoft Control Panel): Choose the time zone of your machine's 
location.

[MUST] 13 Network and Sharing Center (Microsoft Control Panel):
a Select Change adapter settings. Right-click Local Area Connection > Properties > 

Configure.
b On the Power Management tab, clear all check boxes. 

[MUST] 14 Programs and Features (Microsoft Control Panel):
a Click Turn Windows features on or off.
b Enable .NET 3.5 by selecting the .NET Framework 3.5 (includes .NET 2.0 and 3.0) 

check box. 
This option requires an internet connection.
12 OpenLab EZChrom Workstation Installation



Configure your Workstation PC  
Configuring Windows 10
c To make sure that all the net.tcp components are properly initialized, Non-HTTP 
activation must be enabled. Expand the .NET Framework 3.5 (includes .NET 2.0 
and 3.0) node and select the Windows Communication Foundation Non-HTTP 
Activation check box.

d Select the .NET Framework 4.6 Advanced Services check box. Use the default 
values for sub items.

e Select the Internet Explorer 11 check box.
f Select the Telnet Client check box.
g Select the TFTP Client check box.
h Reboot the PC.

[MUST] 15 Start > Settings > System > Default Apps: Select Internet Explorer as default Web 
browser. 
Do not use Edge, it is not supported. Unpin Edge from the task bar.

[MUST] 16 Disable Compatibility View in Internet Explorer.
a Open Internet Explorer.
b Click the Tools menu, and then click Compatibility View Settings. 
c Clear the Display intranet sites in Compatibility View check box.

[MUST] 17 Enable the navigation pane:
Open Windows Explorer, then select View > Navigation pane from the ribbon and 
make sure that Navigation pane is selected.

[MUST] 18 Disable Admin Approval Mode for the Built-in Administrator account:

a On the Start screen, type Local Security Policy, and press ENTER.

b Navigate to Local Policies > Security Options.

c Double-click the User Account Control: Admin Approval Mode for the Built-in 
Administrator account policy.

d Select Disabled, and click OK.

NOTE If this procedure does not work as expected, or the computer has no internet access, install 

.NET 3.5 from the Windows installation media (see details for Windows 10 under 

https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, 

create them as described under 

https://www.microsoft.com/en-us/software-download/windows10.
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Configure your Workstation PC  
Configuring Windows 10
[MUST] 19 Automatically detect intranet network:

a Open Internet Explorer.

b Click the Tools menu, and then click Internet Options.

c On the Security tab, select Local intranet, and click Sites.

d Select Automatically detect intranet network.

e Click Advanced.

f Add the network path from where the EZChrom installer is mapped, and 
click Close.

[PERFORMANCE] 20 System (Microsoft Control Panel): Change performance options:
a Click Advanced system settings.
b On the Advanced tab > Performance click Settings.
c On the Visual Effects tab, select Adjust for best performance.
d Under Custom, select the following check boxes for better usability:

• Smooth edges of screen fonts

• Show shadows under mouse pointer

• Show shadows under windows

[PERFORMANCE] 21 Start > Settings > Personalization > Colors: Turn  Make Start, taskbar, and action 
center transparent off.

[PERFORMANCE] 22 System (Microsoft Control Panel): Change system properties:
a Click Advanced system settings.
b On the Advanced tab > Performance click Settings. 

• Advanced tab > Virtual Memory: For optimum performance use the Change 
button to adjust the paging file size to a value of 2 to 3 times of the physical 
RAM on the PC. If possible locate the paging file on a drive different from the 
system installation drive.

• Data Execution Prevention tab: Select Turn on DEP for essential Windows 
programs and services only.
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Configure your Workstation PC  
Configuring Windows 10
c Advanced > Startup and Recovery > Settings button:
• System startup section: 

Change both Time to display ... fields from 30 to 3 sec. 
• System failure section: 

Select Automatically restart, in the Write debugging information section select 
Kernel memory dump from the drop-down list.

d System Protection tab
Make sure that Protection is turned off. If required, click Configure and select 
Disable system protection.

e Remote tab
• In the Remote Assistance section, clear the check box Allow Remote 

Assistance connections to this computer. 
• In the Remote Desktop section, select Don't allow connections to this computer. 

[OPTIONAL] 23 Start > Settings > Personalization: Disable advertising info:
a On the Lock screen page:

• Under Background, select Picture or Slideshow.
• Turn off Get fun facts, tips, tricks, and more on your lock screen.
• Turn off Show lock screen background picture on the sign-in screen.

b On the Start page:
Turn off Occasionally show suggestions in Start.

[OPTIONAL] 24 Start > Settings > Privacy:
a On the General page, turn off the following:

• Let apps use my advertising ID

• Turn on SmartScreen Filter to check web content

• Send Microsoft info about how I write

b On the Location page, turn off Location.

[OPTIONAL] 25 Start > search for 'gpedit.msc': Welcome Center:
a Navigate to Local Computer Policy > Computer Configuration > Administrative 

Templates > System > Logon.
b Set Don't display the Getting Started welcome screen at logon to Enabled.
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Configure your Workstation PC  
Configuring Windows 10
[OPTIONAL] 26 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the 
following options: 
• Custom size: Select a size corresponding to approximately 10% of the complete 

disk space for the drive.
• Select Display delete confirmation dialog.
Repeat these steps for all drives of your computer.

27 Region (Microsoft Control Panel): Language for non-Unicode programs:

On the Administrative tab, click Change system locale.... From the drop down list, select 
English (United States).

[OPTIONAL] 28 Right-click the taskbar to open the Taskbar and Start Menu Properties dialog. In the 
Taskbar tab, under Taskbar buttons select Combine when taskbar is full.
This will simplify switching between open CDS instances.

NOTE Do not the change system locale if you are using an English, Portuguese, Japanese or 

Chinese Operating System.
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OpenLab EZChrom Workstation Installation
2
Install the Software

The installation is automated by the OpenLab EZChrom Master Installer. Follow 

the wizzard to install all components you need to run OpenLab EZChrom.
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Install the Software  
Before You Begin
Before You Begin

To simplify installation of the software, it is helpful to decide on some configuration 
options before you begin the actual software installation.
1 Decide on a computer name.

The computer name will be reflected in the instrument configuration. To 
avoid considerable effort, it is recommend to keep the computer name 
unchanged after installing OpenLab EZChrom.

2 Decide on how audit trails shall be handled. 

By default, audit trails are disabled and can be activated manually for each 
single project. The installation wizard offers a function to globally enable 
audit trails for all projects.  
Once audit trails are enabled, they cannot be disabled again.

3 For installing EZChrom, you need to have administrator privileges for all 
servers and clients. Power user privileges are not sufficient  
(the installation does not start).

4 Decide on a directory location to store all files related to the data system 
software, including data, methods, sequences, and configurations. The 
directory must always be accessible to the PC running the software. 

5 If you will be using OpenLab ECM with your system, obtain the ECM server 
name.

6 Decide on the software delivery approach you want to use:

NOTE To make sure that a DNS server can resolve the computer name, follow the internet 

standard for protocols (RFC952) and use only the following characters:

Letters (a-z, A-Z)

Digits (0-9)

Hyphen (-)

Do not use an underscore.

NOTE Make sure you have administrator privileges for both ECM and OpenLab.
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Install the Software  
Before You Begin
• Install directly from the DVDs — Load the disks as required directly to 
the workstation disk drive.. (Recommended)

• Copy installation files to a centralized location — You can use the utility 
to copy the installation files, for example, to a network share folder or 
USB drive, and run the installation from that location. However, some 
networks may interfere with installation.

7 When you launch the application, you will be able to review the following 
PDFs in the installer Planning menu before you install the software.

• OpenLab EZChrom Requirements — Use this PDF to check that your 
settings comply with the network requirements, and to determine 
whether your hardware and software will support the system. 

• OpenLab EZChrom Workstation — An electronic copy of this installation 
guide is provided in PDF format for your convenience.

8 Install all required hardware, including any A/D connections, interfaces, 
instrument detectors, and communication cables.

9 Make sure that a default printer is configured in Windows.

This is done via the Microsoft Control Panel. If no default printer is 
configured the following problems may occur:

• Printing of a report preview will fail

• the Copy To Clipboard menu will have an error

• the Custom Report View will have problems with new templates

10 Make sure .NET 4.7.2 is activated as Windows features. 

The .NET 4.7.2 installation files are available on disk 1 
(Disk1\Tools\DotNet4.7). To install .NET 4.7.2, copy the files to a local disk.

NOTE During the installation of the EZChrom, a PDF XChange 6 printer driver is installed. This 

printer has the following limitations:

• The maximum number of pages for one print job is 1500. For example sequence 

summary report is one print job.

• When printing Multi Page chromatograms, the maximum number of pages which can be 

printed properly depends on the resolution of the printer. 300 dpi allows 10 pages, 600 

dpi allows up to 5 pages per chromatogram.
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Install the Software  
Before You Begin
11 Make sure that the antivirus software is disabled during the installation.

12 Make sure that no upgrades will run for any software during the 
installation.

13 Make sure that no system reboot is pending.

Pending reboots are indicated in the Site Preparation Tool (see “Step 4: Run 
the System Configuration Checker” on page 24).

Antivirus exclusions

The following are antivirus exclusions for EZChrom installer programs.

• <Installer Path>\Disk1\Setup\Agilent.OpenLAB.CDSInstaller.exe

• <Installer Path>\Disk1\Setup\Agilent.OpenLAB.InstallerCheckSum.exe

• <Installer Path>\Disk1\Setup\Agilent.OpenLAB.MasterInstaller.exe

• <Installer Path>\Disk1\Setup\Agilent.OpenLABCDSChangeWizard.exe

• <Installer Path>\Disk1\Setup\
Agilent.OpenLABCDSCSAICRegistrationTool.exe

• <Installer Path>\Disk1\Setup\
Agilent.OpenLABCDSRegistrationWizard.exe

• <Installer Path>\Disk1\Setup\Agilent.OpenLABCDSSetupFromDVD.exe

• <Installer Path>\Disk1\Setup\
Agilent.OpenLABCDSUninstallationWizard.exe

• <Installer Path>\Disk1\Setup\Agilent.OpenLABCDSWizard.exe

• <Installer Path>\Disk1\Setup\Agilent.OpenLABiDAWizard.exe

• <Installer Path>\Disk1\Setup\OpenLABCDSUtility.exe

• <Installer Path>\Disk1\Setup\Bin\IQT_Checksum\IQT.exe

• <Installer Path>\Disk4\RegisterEE\registeree.exe

• %temp%\Disk1

• <InstallationDirectory>\SitePrepStartExe

NOTE Run the .NET 4.7.2 installation from a local disk. Windows needs write access to the 

installation files.
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Install the Software  
Step 1: Prepare for Installation
Step 1: Prepare for Installation

To prepare for an installation on your workstation:

1 For the direct DVD approach, insert the OpenLab EZChrom Installation 
disk (Disk1).

2 For the shared file approach, copy all DVDs to a centralized folder as 
described below.

3 For the portable data storage device approach, insert the new device in a 
computer USB port.

To begin installation, navigate to Disk1\Setup.bat. Right-click the file and run it 
as administrator to proceed to the Planning screen.

Step 2: Install Third Party Tools

The OpenLab EZChrom Master Installer offers a list of tools that can be installed 
directly from the Installation screen.

Install Adobe PDF Reader

You need Adobe Reader DC Classic to ...

• view site prep or administrative reports (such as system reports)

• use the Report Viewer feature

• view Software Verification Reports

NOTE If an older version of Acrobat Reader (11 or earlier) is installed on your system, you must 

deinstall it first. Adobe updates would raise those versions to Acrobat Reader DC 

Continuous, which pushes automatic updates on a regular basis.
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Install the Software  
Step 2: Install Third Party Tools
To install Adobe Reader DC Classic:

1 Select Third Party Tools and then Adobe PDF Reader.

a The Adobe Reader setup screen appears. Click Install to continue.

b If Adobe Reader was successfully installed, click Finish to exist the setup 
screen.

Alternatively, you can install Adobe Reader from the installation media. It is 
available under Disk1/Tools/Adobe Reader.

Run AcroRdr_Installer.bat and follow the instructions of the Adobe Reader Setup 
wizard.

Install .NET 4.7.2

For Windows 10: If .NET 4.7.2 is not installed on your system, it can be 
installed by clicking Net Framework 4.7.2 on the installation wizard. However, 
Windows requires write access to the installation files. Installing directly from 
the DVDs will therefore not be possible.

1 Copy the folder Disk1\Tools\DotNet4.7 to a local disk.

2 Run dotNetFx47_Full_x86_x64.bat.

3 Follow the installation wizard. 

NOTE If you install Adobe PDF Reader directly from the installation medium: When OpenLab 

EZChrom users open a PDF file for the first time, they will be asked to confirm the Adobe 

Reader license agreement. This dialog will appear for each newly configured instrument.

NOTE Microsoft .NET Framework 4.7.2 (Offline Installer) supports the following operating 

systems: Windows 10, Windows Server 2016, and Windows Server 2019.
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Install the Software  
Step 3: Copy Installation files to a Centralized Folder for Installation (Optional)
Step 3: Copy Installation files to a Centralized Folder for 
Installation (Optional)

Completing this step will enable you to run an installation from a network 
share.

1 From the OpenLab EZChrom Installer Planning screen, select Installation 
from the sidebar menu.

2 Select Preparation of an Installation from Network Share.

3 At the Network Share screen, browse to a directory and create a destination 
folder as follows:

a Select the button with the three dots.

b Navigate to the directory where you want to create the folder.

c Select Make New Folder.

d Type in the folder name.

e Select OK. The system will return you to the Network Share screen, with 
the path displayed.

f Select the content you want to copy to the folder, corresponding to the 
required installation scenario.

g Select Start.

4 When processing is complete, copy the files to the local drive or map the 
location to a network drive.

5 Close the application and navigate to the directory and folder you created. 
Open the folder.

6 Select the Disk 1 folder, then execute Setup.bat to run the application.

The system will display the installer Planning screen.

NOTE Installations into the root of a drive may cause problems during operations and are not 

supported.
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Step 4: Run the System Configuration Checker
Step 4: Run the System Configuration Checker

1 Run the OpenLab EZChrom Installer from DVD, portable device, or from a 
centralized folder. From the Planning screen, select System Configuration 
Checker.

4 The Site Preparation Tool opens. Select OpenLab EZChrom A.04.10 from the 
drop-down list:

5 Select OK.

6 Complete page 1 of the Contact Information—System details by typing in the 
fields provided.

• System Location fields

• System Information fields

• Configuration fields

7 Review the system details and make any necessary entries. The system will 
follow the paths specified.

8 Select the green check mark icon in the top left corner of the screen to 
begin the software check. A summary report is displayed showing the 
results for each check category. Results are expressed as Pass, Warning, 
Critical Warning, or Fail. 

Fail results must be corrected before continuing with the installation. 
Agilent recommends investigating and correcting any Critical Warnings and 
Warnings whenever possible before proceeding.

9 To view details of the report, select the appropriate link: System Hardware 
Details, Operating System and Software Details, or Manual Verification Required.

10 To save the report, select the Save icon at the top left of the screen.

11 E-mail the saved report to your Agilent Service Representative for 
evaluation, and for validation of your personal computer for Agilent 
Software Systems Installs.

NOTE If the firewall is controlled by security software, the Site Preparation Tool cannot read the 

firewall settings because of security limitations. As a consequence, the Site Preparation 

Tool will display Status "Fail" for the firewall settings.

In this case, make sure the firewall is disabled and enter the status in the Site Preparation 

Tool report manually.
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Step 5: Run the Installation Wizard
Step 5: Run the Installation Wizard

License Agreement Screen

1 From the OpenLab EZChrom Master Installer screen, select Installation.

2 Select OpenLab EZChrom .
3 The OpenLab EZChrom Wizard opens. Read the terms of the License Agreement. 

OpenLab EZChrom Installer provides a printable PDF of the license 
agreement under the Resources option of the main menu.

4 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

5 Select Next to proceed to the Installation Folder screen.

Installation Folder Screen

1 Type the folder name or browse to the directory where you want to store 
the application components. Folders must have English names.

2 To run an installation verification as part of this installation, select Run 
Software Verification. The Software Verification Tool provides documentary 
evidence that your system has been built and installed correctly, and that 
all design specifications have been met. You can run the Software 
Verification Tool at a later time if you prefer (see “Run a Software 
Verification after Software Installation” on page 42).

3 Select Next to proceed to the Installation type screen.

NOTE Installations into the root of a drive may cause problems during operation and are not 

supported.
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Installation Type Screens

1 Under Installation Type, select Standalone Workstation.

2 Select Next to proceed to the OpenLab EZChrom screen. 

The OpenLab Print Server is automatically installed as part of the EZChrom 
installation. The Print Server manages unattended printing during 
acquisition and reprocessing. It monitors a queue folder for PDF files which 
are then sent to a printer.

3 Select Next to proceed to the Additional items screen.

4 If you want to use OpenLab ECM with your data system:

a Depending on your repository, select the OpenLab Server/OpenLab ECM XT 
Server or ECM 3.x Server option button. 

b Type in a server name and press the Test Connection... button.

c The system will perform a connectivity check to verify access to a 
functional OpenLab ECM server. If the connectivity check is successful, 
the message Connection succeeded appears. Click OK to continue. If the 
connectivity test fails, you will be returned to the Additional items screen. 
From here you can select Next to run the test again. If the test is still 
unsuccessful:

• Enter a new OpenLab ECM server and try another test.

• Call internal support for assistance if you cannot connect to an 
OpenLab ECM server.

• You can uncheck the box and run the installation without OpenLab 
ECM at this time. You will be able to add it to your data system at a 
later time, when a server is determined

d Select Next to proceed to the Global Audit Trail Enforcement (GATE) Settings 
screen.

5 In the GATE Settings screen, choose whether audit trails shall be 
automatically enabled on this Workstation. If required, select the Global 
Audit Trail Enforcement check box. 
Once enabled, the audit trails option cannot be turned off again.

6 Select Next to proceed to the Summary screen.

NOTE To disable Global Audit Trail Enforcement feature, run the installation or repair procedure 

again and uncheck the GATE option.
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Summary Screen

1 Review the installation settings that you have selected in the preceding 
steps. Select Back as necessary to change installation settings, or Cancel to 
cancel the installation.

2 Before starting or canceling the installation, you can save an XML file with your 
installation settings. This XML can then be used for a scripted installation (see 
“Scripted Installation” on page 28).
To save the XML file, click the file symbol  in the Summary screen.

3 Select Start to begin installation.

4 The system performs an automated system check before it proceeds with the listed 
activities.
If a system check passed message appears, installation continues.
If a system check failed message appears, you can either:
• Decline to view the system report, and continue installation.
• Decline to view the system report and postpone installation.
• View the system report, and decide to continue installation.
• View the system report and postpone installation until the problem is fixed.

5 If an installation verification was completed as part of this installation, review the 
Software Verification Report. If the report indicates failure, verify the computer 
requirements and reinstall the data system. Do not use the system until the Software 
Verification Report gives a ‘pass’ result.

6 Click Next to proceed to the Installed Features screen.
7 Click Finish to close the installation wizard.

NOTE To view the system report as PDF file, Adobe PDF Reader must be installed (see “Install 

Adobe PDF Reader” on page 21).
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Scripted Installation

The OpenLab EZChrom Installer supports a command line mode for 
installation, the scripted installation. This mode supports installation, 
upgrade, repair, and uninstallation. You can execute scripted installations 
either manually or as part of software management systems such as LANDesk 
or HP CM. With the corresponding parameter (-q), the scripted installation 
completes unattended.

Export as XML 

The OpenLab EZChrom Installer supports a feature to export the installation 
parameters into an XML file which you can then use for the scripted 
installation.

This feature is also supported for upgrade and repair. However, for these cases 
the exported installation XML file is not appropriate. For scripted repair and 
upgrade, you must prepare specific XML files using the respective OpenLab 
EZChrom Installer wizards.

1 Launch the OpenLab EZChrom Installation Wizard.

2 Follow the instructions as described under Install the Software in this 
manual.

3 When you have reached the Summary screen, click the icon  on the top 
right corner to export the installation parameters to XML. Save the file on a 
physical drive.

You can now use the XML file for the scripted installation.

NOTE Installation file and XML file must not be in the same file path.
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Parameters and Return Codes

Parameters

You can call Agilent.OpenLab.CDSInstaller.exe in command line mode with the 
following parameters:

• -i

Installation, upgrade 

• -r

repair

• -u

Uninstallation

• -q

Silent mode — no installation or uninstallation wizard will be shown.

• -reboot

Reboot automatically after successful installation, repair, upgrade, or 
uninstallation. The system will reboot if the return code is either 0 or 17.

A warning message will be shown in the command prompt 10 min before 
the system is rebooted. In addition, a Windows dialog opens 2 min before 
reboot.
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• KeepComponents

Optional parameter for the uninstallation process, which can contain one 
or more shared components that should stay on your system. Without this 
parameter, all EZChrom components will be removed from your system. To 
keep certain shared components, list the corresponding IDs from the table 
below in double quotes and separated by comma.

• ConfigurationXML="<ConfigurationXMLFilePath>"

The XML file contains all required inputs of the OpenLab EZChrom 
Installer to install, upgrade, or repair a certain topology (see “Export as 
XML” on page 28). Replace <ConfigurationXMLFilePath> with the correct 
file path and XML file name.

Component Name Id

Software Verification Tool IQT

Microsoft SQL Server SQLServer

IO Library IOLibraries

NOTE Do not enter a blank before or after the equals (=) sign. The scripted installation and 

uninstallation mode will not work as expected.
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Return Codes

After installation, uninstallation, upgrade, or repair in the command line 
mode, the system will return a number code which is explained below.

Table 2 Return codes

Error/Return Code Return value

Unknown (default) -1

Success 0

CoreComponentFailure 1

NonCoreComponentFailure 2

TestConnectivityFailure 3

ExpectedWindowsInstallerNotInstalled (WI 4.5 missing) 4

ParameterMismatchError 5

CannotProceedWithFreshInstallation 6

CannotProceedWithUpgrade 7

CannotProceedWithUninstallation 8

CannotProceedWithRepair 9

CannotProceedWithReRegistration 10

ReRegistrationNotSupported 11

IncompleteTopologyFound 12

InvalidUNCPath 13

MissingInstallable 14

NotAStrongPassword 15

DowngradeNotSupported 16

RestartRequired 17

RegistryCleanupError 18

InvalidInputXML 19

InvalidMode 20
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SitePrepFailure 21

DatabaseConnectionFailed 22

DotNetFramework4NotInstalled 23

OLSSConnectionFailed 24

PDFReaderNotInstalled 25

AllComponentsInstallationFailed 26

SomeComponentsInstallationFailed 27

Failed 28

AddOnListEmpty 29

EULANotAccepted 30

ScriptedNotSupported 31

Table 2 Return codes

Error/Return Code Return value
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Installation, Upgrade, or Repair

In installation mode, the OpenLab EZChrom Installer checks if .Net 
Framework is present on your system. If not, it will automatically be installed. 
Select Accept to agree with the license agreement.

The OpenLab EZChrom Installer evaluates the products already installed on 
your system. Depending on the installed components, the OpenLab EZChrom 
Installer will offer one of the following options:

• Start a fresh installation

• Upgrade

• Repair

If a required installable is missing, the OpenLab EZChrom Installer will create 
an entry in a log file, and, depending on the component type, will continue or 
rollback the installation. A corresponding error code will be returned in such 
scenarios.

1 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

You will get a return code for the scripted installation only if you start it as 
administrator.

2 Navigate to the drive where you have saved the disks.

For example: C:\CDS_DVD

3 To start the installation, call Agilent.OpenLab.CDSInstaller.exe with the 
following syntax: 

Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="<path to xml 
file>" -q -reboot

For example:

Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="c:\settings\
ConfigurationXML.xml" -q -reboot

With this command, you start the installation wizard without a user 
interface, and automatically reboot the system.

Preparations You must have copied all disks to a centralized folder (see “Step 3: Copy Installation files 

to a Centralized Folder for Installation (Optional)” on page 23). This step is mandatory for 

scripted installation.
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Uninstallation

1 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

You will get a return code for the scripted uninstallation only if you start it 
as administrator.

2 Navigate to the drive where you have saved the disks.

For example: C:\CDS_DVD

3 To start the uninstallation, call Agilent.OpenLab.CDSInstaller.exe with the 
following syntax:

Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="<list of 
components>" -q -reboot

For Example:

Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="IQT,IOLibraries" -q 
-reboot 

With the KeepComponents parameter, you can specify a list of shared 
components that you want to keep on the system (see “Parameters” on 
page 29). With the command given in the example, the EZChrom 
components Software Verification Tool (IQT) and IO Library (IOLibraries) 
will be kept.

Logging and Tracing

All exceptions, errors and information messages are logged in the following 
locations:

• During installation, upgrade, or repair: under <BaseInstallDirectory>\Logs

• During uninstallation: under <User's Temp>\<Company Name>\Logs\<Log 

folder>\<Wizard Name>.txt
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Install Additional Software and Drivers

OpenLab EZChrom offers a wizard to help you installing additional software, 
such as drivers for third-party instruments. To open the wizard, go to Start > 
All programs > Agilent Technologies > OpenLab > OpenLab Additional Software and 
Drivers. Follow the wizard to install the required software.

Prepare Network Drives

If the additional software is located on a network drive, you must prepare the 
network drive to make it accessible by the wizard. Without this preparation, 
Windows security prevents the wizard from accessing those drives.

1 Map the drive to a letter.

For example, map the drive as Z: using the shared path "\\<machine-name>\
OpenLabCDS".

This maps the drive for the logged-in user.

2 Open the command prompt in elevated mode (run as administrator), and 
map the drive using the net use command.

For example,  
net use Z: "\\<machine-name>\OpenLabCDS"
This maps the drive for the local administrator account. The mapped drive 
is now visible to both logged-in user and administrator, and can be selected 
in the wizard.

Configure Third-Party Instruments

For details on the configuration of third-party instruments with OpenLab 
EZChrom, please refer to the documentation of the respective driver.
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What to do Next

The basic installation of the data system software is complete.

There is a 60-day Startup License for this system, and the expiration period 
starts with your first launch of an application.

To request and download your final software license, and add the license file 
to your system, see the Licensing chapter in this guide.

After you have acquired and installed your final software license, you will 
continue to prepare your data system for operation by end users by 
configuring projects, users, and instruments. This is accomplished through the 
OpenLab Control Panel.
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Post Installation Tasks

This chapter describes tasks that are relevant after finishing the installation.
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Configure the Antivirus Program

Be sure to open the firewall ports listed in the Firewall Settings in the 
OpenLab EZChrom Requirements guide.

In order for the OpenLab software to function correctly, you should configure 
any antivirus real time protection software with the following list of folder 
exclusions. These folders should only be scanned while the instruments are 
idle and no data acquisition takes place. Refer to your specific antivirus 
software documentation on how to configure folder exclusions.

• The path that you use to store your data

• C:\programdata\chromatography system\recovery data

• C:\programdata\agilent

• %programfiles%\agilent

• %programfiles(x86)%\agilent

• %programfiles%\common files\agilent

• %programfiles(x86)%\common files\agilent

• %programfiles%\agilent technologies

• %programfiles(x86)%\agilent technologies

• %programfiles%\common files\agilent technologies

• %programfiles(x86)%\common files\agilent technologies

• %programfiles%\common files\agilent shared

NOTE Running antivirus programs might influence the behavior and performance of your 

computer. Some virus scanners might cause issues when used with OpenLab EZChrom. 

The application has been tested with Symantic Endpoint Protection, Trend Micro, Microsoft 

Security Essentials, McAfee. Any of these antivirus software is recommended. However, 

the support is not limited to these antivirus software products. Each product may have 

specific language requirements and support.

NOTE With Symantec Endpoint Protection, do not use the Aggressive Scan Mode. It may lead to 

false positive virus detection.
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• %programfiles(x86)%\common files\agilent shared

If your antivirus software includes program or executable deny execution 
settings, ensure that the following program files are not denied execution. You 
can use the windows search feature to find the specific folder each program 
file is located in.

• agilentiolibrariesservice.exe

• apg_top.exe

• iprocsvr.exe

• iproc8491.exe

• msinsctl.exe

• httpdmsd.exe

• epcsetup.exe

Process Directory File name

ECM upload/download

(if applicable)

%temp% for Windows users

(=Users' temp directory)

*.ssizip

Standard reports %temp% for Windows users

(=Users' temp directory)

~p3d*.tmp

~job*.tmp

Hpspl00.que

CDS intelligent reports %LOCALAPPDATA%

%APPDATA%

%PROGRAMDATA%

Files on:

• Agilent

• Agilent Technologies

• Agilent_Technologies,_Inc

• IsolatedStorage

• Temp

e.g.: C:\Users\xxxxx\
AppData\Local\ Agilent 
Technologies\Intelligent 
Reporting\
RawDataFileCache

NOTE Depending on your specific configuration, some of the listed folders or files may not exist 

on your system.
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Setup the Print Server in the Operating System

1 Browse to the Agilent OpenLab Print Server in Services.

2 Change the Log On As user to a domain user that has access to your printers.

3 Login to the operating system as the user that is logged into the Agilent 
OpenLab Print Server in Services.

4 Install your printers while logged in as this user.

5 Create a folder on the local machine. The user logged into the Agilent 
OpenLab Print Server service needs to have full access to this location. This is 
the folder that the Print Server will monitor for PDF files. Every printer 
needs to have its own queue folder.

NOTE Inside each queue folder, there will be a quarantine folder If the connection to the printer 

fails, print jobs will be added to this quarantine folder. The print jobs be copied back to the 

queue folder manually, once the connection to the printer has been restored. By default, 

files are deleted from the quarantine folder after 24 hours. 
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Optional Procedures

This chapter contains information on the Software Verification Tool, and other 

helpful procedures.
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Run a Software Verification after Software Installation

The Software Verification Tool provides documentary evidence that your 
system has been built and installed correctly, and that all design specifications 
have been met.

1 Using your Windows operating system, go to Start > All Programs > Agilent 
Technologies > Software Verification Tool.

2 Select Qualify.

The system will run the application and generate a Software Verification 
Report.

3 If the report indicates failure, verify the computer requirements and 
reinstall the data system.

Do not use the system until the Software Verification Report gives a ‘pass’ 
result.

Configure Advanced File Security (AFS)

Advanced file security is an optional configuration for OpenLab EZChrom 
networked systems. It provides enhanced security on the enterprise path in 
order to prevent any unauthorized access to project data outside of the data 
system. This configuration sets the appropriate Windows sharing and security 
settings to allow only a defined group to access the enterprise data from 
Windows Explorer. This may only be configured if your system is configured 
to use Windows Domain as the Shared Services authentication provider.
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Enable Advanced File Security

1 Prepare your system.

a Verify that your system is configured to use Windows Domain as the 
authentication provider. (See Configure Security and Storage > Set the 
authentication provider and the storage system in the online help.)

b Verify that your system is configured to use a storage path that is directly 
beneath the defined enterprise path.

c Create or define a Windows Domain group that will have access to the 
enterprise path outside of the data system.

d Define a minimum of two users who are members of the group defined 
above.

e Under Local Security Policy > Local Policies > User Rights Assignment, grant 
the users or the group the following rights:

• Act as part of the operating system

• Allow log on locally

f Close all connections to the OpenLab EZChrom system (i.e. clients, 
instrument runs, control panels).

g Obtain the login credentials of a domain user that has administrative 
rights to edit the enterprise path in its current state.

h Obtain the administrative login credentials of the OpenLab Control Panel 
that were defined during the configuration of domain authentication.

2 On any OpenLab EZChrom client, browse to the directory where the 
software was installed.

(by default: C:\Program Files\Agilent Technologies\EZChrom)

NOTE Non-expiring passwords are recommended. For details on changing the password in a 
running system, refer to the EZChrom Administration chapter in the OpenLab EZChrom 
Guide for Administrators.
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3 Launch EnterpriseConfig.exe.

4 An Enterprise Setup Login dialog will display:

a In the OpenLab Control Panel Login section enter the user name, password, 
and domain of the OpenLab Control Panel Administrator.

b In the Windows User Information section enter the user name and password 
of the user with edit permission to the enterprise path.

• If this is a domain user account, select Logon from Windows Domain and 
enter the domain name (recommended).

• If this is a local PC account, select Windows Local PC. This may only be 
an account local to the machine where the EnterpriseConfig.exe program 
is being run.

c Click OK.

5 The system will process the above credentials. If they are valid, a warning 
will display to advise that once this process is completed, it cannot be 
reversed.

Click OK if you are prepared to proceed.

6 An Enterprise Service Account dialog will display:

a Enter the user name, password, and domain of a user defined to be a 
member of the AFS group.

b Enter the group name that will have access to the enterprise path under 
the restrictions of AFS.

c Click OK.
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Transform a Workstation to a Networked Workstation

Conflict of multiple instruments having the same name

Check if the instruments used on the Workstation have a name that already exists in 

the network. If this is the case, or if you ar not sure:

With Networked Workstations, you use a separate OpenLab Shared Services 
server to control the system. You can access all information provided by 
OpenLab Shared Services from any Networked Workstation. For example, you 
can see on each workstation which instruments are available and which status 
(Online, Offline, Error, In Run, Not Ready, etc.) the instruments currently 
have. Also licenses and user accounts are managed centrally on the OpenLab 
Shared Services server.

1 From the OpenLab EZChrom Master Installer screen, select Maintenance.

2 Select Transformation of an OpenLab Standalone Workstation into a Networked 
Workstation.

3 Enter the server name and the authentication service used by the server.

If the server requires authentication, you will be asked for the credentials of 
an OpenLab Shared Services administrator.

4 Start the transformation.

All instruments will be registered on the OpenLab Shared Services Server.

NOTE • You must already have installed an OpenLab Shared Services server. See Networked and 
Distributed System Installation and Configuration (CDS_NWSDS-Installation.pdf on disk 

1).

• Make sure that the versions of Workstation and OpenLab Shared Services Server are 

identical. If not, upgrade your Workstation before doing the transformation. See 

“Upgrade EZChrom Edition to Latest Version” on page 65.

For more information on temporary support of mixed version systems during an upgrade 

phase, refer to the OpenLab EZChrom Administration Guide (CDS_Admin.pdf on Disk 1).

CAUTION

• Before starting the transformation: Copy the data, methods, and sequences from the 

relevant instrument to a local backup folder. Then delete the instrument on the 

Workstation.

• After the transformation, configure a new instrument, and copy back the data from the 

local folder.
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Improve Performance on Offline Machines

Computers running OpenLab EZChrom may exhibit slow performance when 
they are not connected to the Internet.

The windows operating system has routines built into its operation that 
causes it to continuously search for an online connection in order to update to 
all the latest Windows security certificates when using secure software.

Use the following system settings on all workstations, clients, AICs, and 
servers to remedy this problem.

1 Open Internet Explorer and select Tools > Internet Options. In the Advanced 
tab, clear the following check boxes:

• Security > Check for publisher's certificate revocation

• Security > Check for server certificate revocation

2 Change the following registry keys:

• On 32bit and 64bit systems:

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\
SystemCertificates\AuthRoot] 

"DisableRootAutoUpdate"=dword:00000001

• On 64bit systems:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Policies\
Microsoft\SystemCertificates\AuthRoot]

"DisableRootAutoUpdate"=dword:00000001 

3 Document that you turned off the Root Certificates, as this can prevent 
users from installing other applications.
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Licensing

This chapter contains information on how to obtain and install a license.
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About OpenLab EZChrom Licensing

License Types

The license file is a collection of Product, Instruments, and Add-on's licenses 
(or activation keys) and is installed to your OpenLab EZChrom System. Both 
the OpenLab Workstation PC, or the OpenLab Server in a Client/Server system 
will act as the license serve.

The licenses or activation keys in the license file can either be Shared or 
Counted:

• Shared licenses — system computers and other components can have 
shared, or add-on, licenses — because they share a core license.

• Counted licenses — these licenses are part of the OpenLab EZChrom 
floating licensing strategy. They are not permanently assigned to any one 
component. Instead they are automatically assigned to components, such as 
AICs and instruments, while the components are starting up. The licenses 
are automatically returned when the component is closed. The license 
management program controls license issuance and retrieval.

In this case, the only requirement is that a component is licensed while 
running. You only need enough licenses for all components running 
concurrently, rather than for each installed component.

A startup license for the system allows you to run OpenLab EZChrom for 60 
days after the installation. In order to run the data system software after the 
60-day period, you must install your core license file
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License File

A license file will contain your software license. This file is installed on the 
workstation. The license file is bound to this computer, and cannot be moved 
to another workstation without regenerating the license in SubscribeNet.

Information in the license file defines the number of instruments and other 
options that may be used concurrently with your system.

The most efficient way to manage and maintain your licensing is through the 
Internet. To generate, download, and install a final license for your product, 
you will need:

• The authorization code label provided in the lavender envelope containing 
your Software Entitlement Certificate.

• The URL for SubscribeNet from the Software Entitlement Certificate.

If you have not received a lavender envelope for your product, contact your 
vendor or internal support.
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Obtain a License with SubscribeNet

If you have Internet access, use the following procedure to generate and 
download your license for your OpenLab EZChrom system.

If you do not have Internet access, skip to the section “Other Ways to Obtain a 
License” on page 52.

If you are a new user who has not registered with SubscribeNet, continue with 
the section New Users.

If you have registered with SubscribeNet, skip to the section Users registered 
with SubscribeNet.

New Users

1 From a computer with Internet access, enter the URL provided in the 
Software Entitlement Certificate in an Internet browser.

2 At the bottom of the login page, click click here to register.

3 On the registration page, enter the authorization code from the label and 
complete the profile information (required fields are marked with an 
asterisk *).

The email address you enter will become your login ID.

4 Click Submit. The system will generate and display an account name for you. 

SubscribeNet will send a welcome email with your login ID and password.

5 Log in to SubscribeNet using your login ID and password.

Once you log in, you can use the online user manual link for help with any 
questions you have.

6 Select Generate or View licenses from the left navigation bar.

7 Follow the prompts to generate your new license.

You will be prompted for the HOST NAME of the computer. The host name 
you enter must match with the network name of the computer where the 
Control Panel is running. Do not include any DNS suffix (domain.com) 
references in the entered machine name.
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During this process you will have to enter the MAC address of your license 
server. For workstations, this is the local computer. For client/server 
systems, this is the server.

To retrieve your MAC address from a computer where OpenLab EZChrom is 
already installed, open the Control Panel and browse to the Administration > 
Licenses section. Use the Copy MAC Address or Save MAC Address function to 
obtain the MAC address for license generation.

8 When the system generated the license, view its details, then click Download 
License File. Save the license file to your computer and to a backup location 
(such as a portable storage device).

Use your login ID and password when you revisit the Agilent SubscribeNet 
site to regenerate a license file, add new authorization codes, or further 
configure the license for your system.

Users registered with SubscribeNet

1 Login to SubscribeNet with your e-mail address and password.

2 Select the SubscribeNet account associated with this authorization code, if 
you have more than one account.

3 From the SubscribeNet navigation pane, select Register Authorization Code.

This will allow you to enter your new authorization code and make available 
the new license entitlements

4 Follow steps 6 through 8 in the previous procedure, New Users, to generate 
or view your new licenses.

NOTE If any changes are made to the computer name or domain reference after the license is 

installed, remove the license. A new license will need to be created in SubscribeNet, 

downloaded, and installed.

NOTE If the network adapter that provides the MAC address used during license creation is 

removed from the machine, your license will no longer be valid. A new license will need to 

be generated with a currently available MAC on the license server.
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Other Ways to Obtain a License

If you are unable to generate a license, contact your nearest Agilent technical 
support office. A representative will tell you how to submit an OpenLab 
EZChrom License Generation Form in your location.

Offline Licensing

If an internet connection is not available in your laboratory:

You or your local on-site service engineer will collect the necessary 
information from you to allow Agilent to create a license account on your 
behalf. For phone support in your region, call the sales and service number for 
your region. See the Appendix for a list of numbers for various countries.

Required Customer Information for Agilent License Support:

The following information must be provided to Agilent in order to enable us to 
create a licensing account on your behalf.

1 Collect Account Information:

Your account name will be your company name and Lab name separated by 
a comma. Employee information provided here will be used to define the 
first administrator of your account for future access to the system as 
required. Please prepare the following pieces of information prior to 
contacting your local Agilent sales and service center in order to expedite 
service:

• Company Name

• Lab/Department Name

• First Name

• Last Name

• E-mail address

• Job Title

• Phone #

• Address, City, State/Province, Postal Code, Country
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2 Collect Authorization Code(s):

The authorization code is an alpha-numeric code provided on a label which 
is enclosed in a lavender envelope. If you have received more than one code 
you must provide all codes to ensure that all ordered licenses are granted to 
your account.

3 Receiving your license:

Once the above information is provided Agilent will then work on your 
behalf to generate a license file through SubscribeNet. The license file will 
either be sent to your shipping address (on a CD), or your local FSE will 
deliver it in person (usually on USB media). Once your license is received 
follow the below section on “Install your License” to finish installing your 
license on your CDS system(s).
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The license must be added to your system using the Control Panel.

1 Start the Control Panel shortcut on the desktop or go to Start > All Programs > 
Agilent Technologies > OpenLab Shared Services > Control Panel.

2 Navigate to Administration > Licenses.

3 In the ribbon, click Add License .

4 Choose to install the license by:

• Using the license file option to browse to and open the license file (.lic) 
saved from the license generation process in SubscribeNet.

• Selecting the License Text option and copying the license text from a text 
file received into the provided field.

5 Click OK.

• The Administration interface in the Control Panel will now display the 
status of installed licenses.
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Configure OpenLab EZChrom in the 
Control Panel

This chapter describes the initial configuration steps after installing the 

software. Refer to the online help for more information.
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Authentication

Authentication Provider

Authentication providers are used to prove the identity of users that log in to 
the system. OpenLab Shared Services support the following Authentication 
providers:

• None

In this mode, no login screen is shown when you access the OpenLab  
Control Panel. The user is automatically logged in to the application with 
security disabled. All log entries record the user as "Anonymous". With the 
authentication provider None, the Security Policy and User Management 
nodes are unavailable in OpenLab Control Panel.

• Internal

In this mode, the user's credentials are created and stored in the OpenLab 
Shared Services database. You are asked to create an administrator account 
for OpenLab Shared Services before setting up other users. This is the only 
mode in which you can create new users within the system.

• Windows Domain

• You import existing Windows users into OpenLab Shared Services. The 
authentication is done either by a Windows Active Directory domain or 
NT 4.0 Domain within the Enterprise. Shared Services only use the 
identity and password of the mapped users; roles and privileges for 
OpenLab EZChrom are still configured with the Shared Services.

NOTE With the authentication provider None, any activity logs will display a generic System 

operator with no additional identification. This is not recommended for regulated 

environments.
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• ECM

• In this mode, an OpenLab ECM system is responsible for authentication. 
When you start the OpenLab Control Panel, the application will prompt 
for ECM credentials to validate a user. You must choose an existing ECM 
user as an administrator for the Shared Services. The Search function 
helps you to find specific ECM users. The Shared Services only use the 
identity and password of the mapped users; roles and privileges for 
OpenLab EZChrom are still configured with the Shared Services.

Configure Authentication

1 Launch the Control Panel.

2 Navigate to Administration.

3 In the navigation pane, select System Configuration.

4 In the ribbon, click Edit System Settings.

5 Select the required authentication provider from the drop-down list, then 
click Next.

6 Provide user credentials:

a For Windows Domain: Select the check box to use a domain user, and 
provide user credentials with the rights to obtain user and group 
information. Then click Select Account to open the Search Users dialog and 
select an administrator account.

b For Internal: Click Create Account to create a new administrator account 
for OpenLab EZChrom.

7 Confirm your settings. When complete, the Control Panel will restart.
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Configure Security Policy

If you need to comply with specific standards, adjust the security policy as 
required.

With the authentication provider Internal, you can set all parameters in the 
Control Panel. With an external authentication provider, you can only set the 
inactivity time in the Control Panel; all other parameters are defined by the 
external system.

1 Launch the Control Panel and navigate to Administration.

2 In the navigation pane, select Security Policy.

3 In the ribbon, click Edit Security Policy.

Configure Users/Groups/Roles

With internal authentication, you create the required users in the OpenLab 
Control Panel. With external authentication system such as Windows domain, 
you import the users.

To define what users are allowed to view or do, OpenLab EZChrom offers 
predefined roles and allows you to define your own specific roles. Roles are 
equipped with numerous specific privileges.

Each user can be member of multiple groups. You must assign one or more 
specific roles to each group. You can also assign roles to single users; however, 
for the sake of clarity, it is strongly recommended to assign roles only on the 
group level. Every member of a group automatically has all roles of this group.

1 Launch the Control Panel and navigate to Administration.

2 In the navigation pane, select Users, Groups, or Roles.

3 Create new items, or edit the existing ones.
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Create or import users

Use the OpenLab Control Panel to manage the roles and privileges. You can 
create custom roles, or assign one or more of the predefined roles to give users 
varying degrees access.

Add users (Internal Authentication only)

1 From the navigation pane, click Administration > Users.

2 In the Create User dialog, provide the relevant parameters:

• Enter the name and password for the new user.

• By default, the new user will need to change the password at next logon. 
If this is not required, clear the User must change password at next logon 
check box.

• In the Role Membership tab, assign the user to an appropriate role. You 
can use the default roles, or prepare your own roles in the Control Panel 
under Administration > Roles.

3 Click OK.

Import users

To add Windows domain users to your system, you must have privileges to 
obtain user and group information from the domain.

1 From the navigation pane, click Administration > Users.

2 In the ribbon, click Import.

3 In the Search Users dialog box, enter search string for the username.

4 From the Search Results list, select the user you want to import, and click 
Add. The user is added to the Selected Users list.

5 Repeat steps 2 through 4 until you have added all the user names that you 
want to import to the Selected Users list, then click OK.
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Groups

If you use an external authentication provider, you can either import the 
names of groups that exist in the external system, or create new internal 
groups. There is no limit on the number of groups that can be mapped or 
created.

Assign users to groups either in the external system or in the Control Panel. If 
you need additional user assignments that are relevant only for OpenLab 
EZChrom, create them in the Control Panel. Otherwise it is sufficient to only 
import the groups and assign the required roles to the groups.

If you delete or unmap a group, the users who were members in this group 
remain unchanged.

Roles and Privileges

Roles are used to assign privileges to a user or a user group globally or for a 
specific instrument or location. The system contains a list of predefined roles 
which are installed as part of the system installation (for example, Instrument 
Administrator, Instrument User, or Everything). Each role has certain privileges 
assigned.

Privileges are grouped according to the three main role types (Project role, 
Instrument role, and Administrative role). When you assign privileges to a 
role, you first select the required role type and then select the privileges 
related to this role type. Each role can only have privileges of one specific role 
type; the only exception is the predefined role Everything, which has all 
privileges of all role types. Users or groups may require multiple roles to 
perform system functions. For example, a user with the role Chemist may 
need another role such as Instrument User with the privilege to run an 
instrument.

You can create a tree of different locations in the Control Panel, and add 
instruments to the relevant locations. For each instrument or instrument 
group, you can assign different Instrument roles (see also “Specific Roles for 
Individual Instruments” on page 62). For example, a user can have the role 
Instrument Administrator for one instrument, and Instrument User for another 
instrument.
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You can also create a tree of different projects or project groups in the Control 
Panel, and assign different Project roles for different projects (see also 
“Specific Roles for Individual Instruments” on page 62). For example, a user 
can have the role Project Administrator in one project, so that he can manage the 
settings in the Control Panel. In a second project, he may have a role that 
allows him to edit the content of a project, but not to change the project 
settings. 

Table 3 Description of role types

Role Type Description

Administrative privileges These privileges are globally assigned to a user or group and cannot be 

changed on the instrument/location level. They are the typical 

administration privileges such as Backup and restore, Manage 
security, Manage printers etc. 

Instrument privileges These privileges can be assigned globally or on the 

instrument/location level. Privileges for instruments are, for example, 

View instrument or location and Run instrument.
Users need the View instrument or location privilege on the global 

level to see the locations and instruments tree in the Control Panel.

Project privileges Privileges for accessing or modifying different levels of data. You can 

assign these privileges globally or on project level.
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Specific Roles for Individual Instruments

By default, the roles of users or groups are globally set for all locations or 
instruments. The role settings are inherited from the root node Instruments. In 
order to assign a different role to a user or group for one specific node, you 
can deselect the Inherit privileges from parent check box in the Edit Privileges 
dialog for the required node. Afterwards, you can assign a different role that 
will be valid only for the specific node. 

You can assign Instrument roles to individual locations or instruments. 

Administrative roles are always set globally.

Configure Initial Project

1 Launch the Control Panel and navigate to Projects.

2 Create and configure a project:

On the EZChrom Settings tab:

• Enter the locations for Methods, Sequences, Results, Sequence Templates 
and Report Templates.

• Consider the required audit trail settings for this project.

For more details, refer to the Control Panel online help.
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Configure Initial Instrument

1 Launch the OpenLab Control Panel and navigate to Instruments.

2 Click Create in the ribbon to create a new instrument.

3 Provide the information on the instrument, and click OK.

4 Select the new instrument, and click Configure Instrument in the ribbon.

5 It is recommended that you use Auto Configuration to configure your 
instruments: Select a module, click Auto Configuration, and enter the Number 
of Detectors and Number of Pumps. Select Autosampler if necessary.

Alternatively, configure the devices manually:

a Select a module from the Available modules, and click the arrow to move 
it under Configured modules.

b Double-click a Configured module to open a dialog box pertaining to that 
module.

c Select Options.

d In the Configuration Options dialog box, select from the following general 
options: System Suitability, SEC, PDA, and Baseline check.

6 Confirm your settings

For more information on the number of supported instrument connections, 
please refer to the Requirements guide.

NOTE Agilent 1120 and 1220 instruments are configurable under the instrument type Agilent 
Compact LC only. They can be combined with other selected LC modules. Please see the 

Supported Instruments and Firmware Guide (CDS_SupportedInstFirmware.pdf) for more 

details.

The drivers for 1120 and 1220 instruments come with the instruments and are not included 

by default with OpenLab EZChrom. 
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Configure the Print Server in OpenLab

If you installed the Agilent OpenLab Print Server:

1 Log in to the Control Panel, and click on the Printers icon in Administration. 

2 Click Add in the Printers menu.

3 Click the Add Monitor button.

4 In the Add New Printer dialog, add the following:

• Monitoring Folder: Enter the UNC or local path to the queue folder (see 
“Setup the Print Server in the Operating System” on page 40).

• Printer: Select a printer that is installed on the operating system.

• Display Name: – Enter the display name for the print monitor

• Comment: Enter a comment

5 Click OK.

6 In the Print Server, select the printer that you just added.

7 Click Monitor On, and set Set to Monitor for this printer to yes. This will enable 
the print server to monitor the queue folder.

If you set Set to Monitor to no, then the print server will not monitor this 
folder and send files to the printer.

8 Set the print server status Running.

If yo click Stop Print Server, the print server service will shut down and the 
print server will stop functioning. None of the printers will be working at 
this point.

NOTE To print to the print server on a workstation: Select your printer in the Print Hardcopy 

section of the screen when starting a single run, starting a sequence, or reprocessing.
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Upgrade EZChrom Edition to Latest 
Version

This chapter describes the upgrade from EZChrom Edition A.04.0x.
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Planning the Upgrade of EZChrom A.04.0x

Before upgrading, make the following basic decisions.

Do you intend to run EZChrom on Windows 10?

An in-place upgrade from Windows 7 or 8.1 to Windows 10 on an existing 
EZChrom Workstation is not supported.

Implications are:

• You will have to install OpenLab EZChrom A.04.10 on your new Windows 10 
PC. See “Post Installation Tasks” on page 37.

• You will have to move your data to the new system.

Upgrade on Windows 10

See “Upgrade EZChrom to A.04.10” on page 67.
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Upgrade EZChrom to A.04.10

The procedure to upgrade to EZChrom A.04.10 depends on the revision of 
your currently installed EZChrom Edition. A direct upgrade is only supported 
from A.04.09 or higher.

• Rev. A.04.09: Run the upgrade wizard. EZChrom will be upgraded to 
A.04.10. 

If your system is configured to use one of the following ELSD drivers 
(G7102A, G4261A/B, or G4260A/B), the ELSD driver will be updated to 
version A.01.08.

• Rev. A.04.08 or lower: 

1 Run the upgrade wizard from the A.04.09 media. EZChrom will be 
upgraded to A.04.09.

2 Run the upgrade wizard from the A.04.10 media. EZChrom will be 
upgraded to A.04.10.

• Rev. A.04.0SR2 or lower: Uninstall the old EZChrom, and install A.04.10.

If your system is configured to use one of the following ELSD drivers 
(G7102A, G4261A/B, or G4260A/B), uninstall the ELSD driver using the 
Add/Remove programs option from the Windows Control Panel.
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License Upgrade

Get Upgraded License File

You will need to upgrade your licenses in SubscribeNet prior to upgrading to 
the next version of OpenLab EZChrom. We strongly recommend upgrading 
your workstation licenses before upgrading the core software. Standalone 
workstations which are upgraded to the new core software version, without a 
new workstation license, will not work until the new workstation licenses are 
added to the OpenLab Control Panel.

If you are under SMA subscription, proceed as follows to upgrade your 
licenses:

1 During the following process, you will be prompted in SubscribeNet for the 
host name or MAC address of the workstation where OpenLab EZChrom is 
already installed.

To retrieve this hostname and MAC address, open the Control Panel and 
browse to the Administration > Licenses section. Note down the host name 
and use the Copy MAC Address or Save MAC Address function to obtain the 
MAC address.

2 Log into the Agilent Electronic Software and License Delivery 
(https://agilent.subscribenet.com/).

3 Navigate to Manage Licenses by Host. In the Host ID field, enter the previously 
noted MAC address, and click Search.

If the relevant host name does not appear, you may be managing your 
licenses in multiple SubscribeNet accounts. You will need to log into those 
accounts to upgrade those workstation licenses.

4 If your license(s) are eligible for an upgrade, you will see the Upgrade All 
button. Otherwise you will need to contact your Agilent Sales 
Representative to renew your Software Maintenance Agreement. To 
proceed with generating your upgrade license, click the button.

5 On the Upgrade All Licenses for License Host page, review the data, and 
confirm by clicking Upgrade All.

This upgrades the license file to the most current version. SubscribeNet will 
send you an email with a new license file.
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6 Put the new license file on your system (see “Add Upgraded License File to 
the System” on page 69.

• If you have multiple standalone Workstations, repeat this step for each 
individual workstation.

• Note that each workstation's MAC address is the file name. This helps 
identify the correct license file to import into the workstation's Control 
Panel.

Add Upgraded License File to the System

If you have purchased new options, such as additional instrument controls or 
client license and regenerated your license in SubscribeNet, the upgraded 
license file must be re-applied to the system.

1 Start the Control Panel from any machine connected to the system you 
want to install the license for.

2 Navigate to Administration > Licenses.

3 In the ribbon, click Remove License.

4 In the ribbon, click Add License.

5 Browse to and open the license file saved from the license generation 
process in SubscribeNet.

6 Restart the following Windows services:

• Agilent OpenLab License Server

• Agilent OpenLab Licensing Support
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Run the Upgrade Wizard

1 From the OpenLab EZChrom Installer Planning screen, switch to the 
Installation screen.

2 Select OpenLab EZChrom.

If OpenLab EZChrom is already installed, this automatically opens the 
OpenLab EZChrom Upgrade Wizard.

3 The workstation license must be upgraded see “License Upgrade” on 
page 68.

Acknowledge that the license has been upgraded and click Next to continue.

4 Select I agree with the terms and conditions. You cannot proceed with the 
upgrade unless you agree to these terms. Click Next. 

5 If an Authentication Provider has been configured: Enter the username and 
password of a user with system administration privileges in the OpenLab 
Shared Services Settings for Registration screen. Click Next.

6 In the GATE Settings screen, choose whether audit trails shall be 
automatically enabled on this Networked Workstation. If required, select 
the Global Audit Trail Enforcement check box. Click Next. 
Once enabled, the audit trails option cannot be turned off again.

4 In the Summary screen of the Upgrade Wizard, the components for the 
upgrade are listed. Click Start to proceed with the upgrade.

If an error occurs during the upgrade, an error message appears.

5 After the upgrade is finished, select Finish to close the OpenLab EZChrom Upgrade 
Wizard.
Existing instrument configuration can remain unchanged after the upgrade. 

NOTE For 35900 instruments, classic driver is automatically installed by OpenLab EZChrom 

Installer. If you need to use RC.NET drivers (for example, to split channels between two 

instruments on an AIC), you must first install the new drivers, and then reconfigure the 

instruments.

Note that methods created with the classic drivers cannot be used anymore. You will have 

to create new methods the with RC.Net drivers.

NOTE Starting with A.04.08 classic drivers for fraction collectors are not supported. You must 

change your instrument configuration and create new methods with RC.NET drivers.
70 OpenLab EZChrom Workstation Installation



OpenLab EZChrom Workstation Installation
8
Uninstall the Software

This chapter contains information on the uninstallation by using the OpenLab 

EZChrom Uninstallation Wizard. It also describes post uninstallation tasks that 

are essential if you plan to reinstall EZChrom on the same computer.
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About Uninstallation

Like the installation, the uninstallation of OpenLab EZChrom is automated by 
the OpenLab EZChrom Installer. 

For your convenience, the OpenLab EZChrom Installer uses the same user 
interfaces for the software uninstallation of all configurations (standalone or 
networked workstation). The OpenLab EZChrom Uninstallation Wizard under the 
Maintenance section of the OpenLab EZChrom Installer guides you through the 
uninstallation steps.

NOTE If the OpenLab EZChrom Installer was not used for installation, any manually installed 

additional software such as Headspace, PAL, or third party drivers must be uninstalled 

using the Windows Control Panel before the OpenLab EZChrom can be uninstalled.

NOTE Do not use the Windows uninstallation tool for uninstalling OpenLab EZChrom.
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Run the OpenLab EZChrom Uninstallation Wizard

1 Select Start > OpenLab > Uninstall OpenLab EZChrom.

2 Select OpenLab EZChrom Uninstallation.

The OpenLab EZChrom Uninstallation Wizard opens.

3 In the Shared Components screen, check the Uninstall Software Verification 
check box.

Note: Software Verification Tool needs to be uninstalled if you wish to 
re-install OpenLab EZChrom at a later time

4 In the Summary screen under Uninstallation of OpenLab EZChrom Components, 
there is a list of the components you want to uninstall.

5 Select Start to start the uninstallation.

If you want to abort the uninstallation, select Cancel. If you want to change 
any settings, select Back.

All listed components are automatically uninstalled, one after another.

6 When the uninstallation has finished, click Finish to close the uninstallation 
wizard.
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Sales and Support Assistance

Please check the following web site for your local sales and support contact:

https://www.agilent.com/en-us/contact-us/page

https://www.agilent.com/en-us/contact-us/page
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